 
   
    
     
      
    
 
     
      
       
       
     
 
    
 
   
 
   
     
     
      
       
        
        A simple and free way of reducing PDF file size using Preview
 
        
          Note: this is a copy and update of a 5 year old discussion in the Mac OS X 10.5 Leopard discussions which you can find here: https://discussions.apple.com/message/6109398#6109398

This is a simple and free solution I found to reduce the file size of PDFs in OS X, without the high cost and awful UI of Acrobat Pro, and with acceptable quality. I still use it every day, although I have Acrobat Pro as part of Adove Creative Cloud subscription.

Since quite a few people have found it useful and keep asking questions about the download location and destination of the filters, which have changed since 2007, I decided to write this update, and put it in this more current forum. 

Here is how to install it:

Download the filters here: https://dl.dropboxusercontent.com/u/41548940/PDF%20compression%20filters%20%28Un zip%20and%20put%20in%20your%20Library%20folder%29.zip

Unzip the downloaded file and copy the filters in the appropriate location (see below).

Here is the appropriate location for the filters:

This assumes that your startup disk's name is "Macintosh HD". If it is different, just replace "Macintosh HD" with the name of your startup disk.

If you are running Lion or Mountain Lion (OS X 10.7.x or 10.8.x) then you should put the downloaded filters in "Macintosh HD/Library/PDF Services". This folder should already exist and contain files. Once you put the downloaded filters there, you should have for example one file with the following path:

"Macintosh HD/Library/PDF Services/Reduce to 150 dpi average quality - STANDARD COMPRESSION.qfilter"

If you are running an earlier vesion of OS X (10.6.x or earlier), then you should put the downloaded filters in "Macintosh HD/Library/Filters" and you should have for example one file with the following path:

"Macintosh HD/Library/Filters/Reduce to 150 dpi average quality - STANDARD COMPRESSION.qfilter"

Here is how to use it:

Open a PDF file using Apple's Preview app,

Choose Export (or Save As if you have on older version of Mac OS X) in the File menu,

Choose PDF as a format

In the "Quartz Filter" drop-down menu, choose a filter "Reduce to xxx dpi yyy quality"; "Reduce to 150 dpi average quality - STANDARD COMPRESSION" is a good trade-off between quality and file size

Here is how it works:

These are Quartz filters made with Apple Colorsinc Utility.

They do two things:

downsample images contained in a PDF to a target density such as 150 dpi,

enable JPEG compression for those images with a low or medium setting.

Which files does it work with?

It works with most PDF files. However:

It will generally work very well on unoptimized files such as scans made with the OS X scanning utility or PDFs produced via OS X printing dialog.

It will not further compress well-optimized (comrpessed) files and might create bigger files than the originals,

For some files it will create larger files than the originals. This can happen in particular when a PDF file contains other optomizations than image compression. There also seems to be a bug (reported to Apple) where in certain circumstances images in the target PDF are not JPEG compressed.

What to do if it does not work for a file (target PDF is too big or even larger than the original PDF)?

First,a good news: since you used a Save As or Export command, the original PDF is untouched.

You can try another filter for a smaller size at the expense of quality.

The year being 2013, it is now quite easy to send large files through the internet using Dropbox, yousendit.com, wetransfer.com etc. and you can use these services to send your original PDF file.

There are other ways of reducing the size of a PDF file, such as apps in the Mac App store, or online services such as the free and simple http://smallpdf.com 

What else?

Feel free to use/distribute/package in any way you like. 
        
 

         
         Thanks ioscar.

The original link should be back online soon.

I believe this is a Dropbox error about the traffic generated by my Dropbox shared links.

I use Dropbox mainly for my business and I am pretty upset by this situation.

Since the filters themsemves are about 5KB, I doubt they are the cause for this Dropbox misbehavior!

Anyway, I submitted a support ticket to Dropbox, and hope everything will be back to normal very soon. 

In the meantime, if you get the same error as ioscar when trying to download them, you can use the link in the blog posting he mentions.

This is out of topic, but for those interested, here is my understanding of what happened with Dropbox.

I did a few tests yesterday with large (up to 4GB) files and Dropbox shared links, trying to find the best way to send a 3 hour recording from French TV - French version of The Voice- to a friend's 5 year old son currently on vacation in Florida, and without access to French live or catch up TV services. One nice thing I found is that you can directly send the Dropbox download URL (the one from the Download button on the shared link page) to an AppleTV using AirFlick and it works well even for files with a large bitrate (except of course for the Dropbox maximum bandwidth per day limit!). Sadly, my Dropbox shared links were disabled before I could send anything to my friend.

I may have used  a significant amount of bandwidth but nowhere near the 200GB/day limit of my Dropbox Pro account.

I see 2 possible reasons to Dropbox freaking out:

- My Dropbox Pro account is wronngly identified as a free account by Dropbox. Free Dropbox accounts have a 20GB/day limit, and it is possible that I reached this limit with my testing, I have a fast 200Mb/s internet access.

- Or Dropbox miscalculates used bandwidth, counting the total size of the file for every download begun, and I started a lot of downloads, and skipped to the end of the video a lot of times on my Apple TV.
 
         
 
          more
 

          
          Similar Messages
 
          
 
           	 
		     Reducing PDF File Size Using Preview
 
			 Hi All,
 Trying to reduce the size of a large pdf file. "Quartz Filter" pick in Preview (Snow Leopard) is no longer available in Lion.
 Tried making new filter in ColorSync Utility and applying, but file size is still not reducing, in fact it increases. Any advise out there?
 Thanks.
 
			 It is available, it's just that versioning is reaking havoc with folks 'cause you have to change your workflow:
 
		   

 
           	 
		     Exporting a book to pdf - any way to reduce the file size?
 
			 Hi,
 So I have made a book using iPhoto and would like to send a pdf copy of it to another person who will fill in the texts. I am able to save the book as pdf via the print menu but the resulting file is over 300 mb in size (the book has only 20 pages)! On the one hand i like the fact that iPhoto is not downsampling my photos but it's a bit difficult trying to send a 300+ mb file over email  Is there any way to create a pdf with the images compressed so i could send it as an attachment?
 
			 http://beyondteck.blogspot.com/2008/11/how-to-reduce-pdf-file-sizes-on-mac.html

Google is your friend.

Regards

TD
 
		   

 
           	 
		     Reducing PDF File Sizes
 
			 We create and use numerous pdf files, some with fill-in fields and some without. Is there a way to reduce the file size without adversely affecting response time to open the file? Some of us are running Acrobat Professional version 7 and others are running version 8. Some of us have Windows XP and some have Windows 2000. 
 Any help you can give us would be greatly appreciated. 
 Thanks. 
 Ken K
 
			 >I thought that if a file was compressed in some way that it might take some time to decompress the file. 

I see - entirely reasonable to think that. However, almost every PDF

is already compressed using technologies like ZIP or JPEG. When you

reduce the file size you are usually doing some combination of

* reducing image resolution

* using more agressive JPEG compression

* deleting stuff you can live without

So this doesn't affect the load time.

JPEG 2000 compression is stronger and a bit slower, but probably

nothing to worry about, especially if you don't have high resolution.

Aandi Inston
 
		   

 
           	 
		     Reduce .PDF file size in Acrobat 5.0
 
			 Hi. Seems like there are plenty of ways to reduce the file size of .pdfs in later versions of Acrobat than in 5.0. Does anyone know of any I could try in the 5.0 version? 
 The doc is 122 pages, all in black & white & has some images.
 I do not have the original doc. I did not make it. I am just trying to reduce the size to put it on the web.
 ps-I did try using Distiller, but the images got a little too sketchy looking.
 Thank you.
 Jules
 
			 I tried it at home & I used the optimize pdf thing. It went from 17MB to 12MB so I re-optimized it & got it down to 3MB. It's as good as it is going to get. The big problem is that the .pdf that I have was scanned on a copier machine.

I printed the 3MB pdf on the color printer & it came out okay, but then I printed it on the black & white printer & it barely had any ink on the page....

I am just going to not bother with it anymore. Not much I can do with a scanned document & it's not even my job to begin with!

Thanks Bill.

Jules
 
		   

 
           	 
		     Do we have some way to reduce Dimension table size using NLS?
 
			   Initially we thought the Cube
      archive in NLS would be like:
 Replicate Cube in NLS with DAP.  DAP creation will create a new structure same like "Star Schema".
 While we load data to NLS it deletes from DB.
 And hence it reduced size of the DB.
 Associated Dimensions will also be replicated in the NLS.
 After actually implementation we found :
 Fact table size is reducing and DB size with associated E/F fact table is reducing
 Dimension tables are still there in DB, and still saving space in DB.
 Do we have some other way to reduce Dimension table size using NLS?
 As when we are analyzing top 100 tables in SAP BW, we are seeing multiple dimensions are part
 of this list.
 Thanks,
 Jaydip
 
			 Hi Jaydip,

Please check below link it might be helpful for you.

http://www.informatik.uni-jena.de/dbis/lehre/ss2011/dbarch/SAP_BW_DB2_NLS_22062011.pdf
 
		   

 
           	 
		     Is there a way to reduce the installation size of preview edition?
 
			 Is there a way to reduce the installation size of preview edition?
 
			 Hi IndianLamp,

Thank you for posting in MSDN forum.

Based on your issue, you mean that you want t reduce the installation size of the version of VS Preview, am I right?

If yes, I know that when we download the version of the VS Preview from the Microsoft Official, it is default that the install package size. However, you can try to unselect some components during the installation, it will reduce the installation size of

 preview edition.

If I misunderstanding your issue, please tell me more detail message about your issue.

Best Regards,

We are trying to better understand customer views on social support experience, so your participation in this interview project would be greatly appreciated if you have time. Thanks for helping make community forums a great place.

Click 

HERE to participate the survey.
 
		   

 
           	 
		     Question about reducing PDF file size on export
 
			 I have a large file that is generates a PDF about 75MB when exported with the "[High Quality Print]" preset. However, I can reduce the size down to to under 5MG in Acrobat if I use the Tools>Flattener Preview>[Medium Resolution] setting (image attached). Is there a way to generate this smaller file directly from InDesign? I couldn't figure out how to do this with InDesign's Flattener Preview or Export options, but it is very likely that I missed something.
 
			 Eugene Tyson wrote:

When you choose Smallest File size, it is still using the PDF 1.6 setting.

Change this to Acrobat 4 (PDF 1.3) this will automagically flatten the PDF - which means you shouldn't have to do it in Acrobat.

That should get you a nice small file size, I believe.

Flattening transparency in InDesign will not necessarily yield a smaller PDF file size. Transparency flattening will not automatically convert placed vector artwork to raster images unless that vector artwork is actually involved with transparency. And even then, whether you end up with a smaller file depends on a number of factors.

If the reason for the very large file size is indeed very complex vector artwork and you are willing to sacrifice quality, conversion of such vector artwork to raster might yield a significantly smaller exported PDF file. To accomplish that conversion, I would personally suggest converting the most offensive (in terms of file size and complexity) of such files in Illustrator (assuming that they were .AI files) and exporting them as .TIF files (to avoid the potential imaging artifacts of JPEG compression).

          - Dov
 
		   

 
           	 
		     Reduce PDF File Size - any ideas?
 
			 Hi all,
 I have a C++/C# programs that generates PDF's in Adobe Reader using Infragistics.  This is a recent change from using VS View as our old method of illustrating - we now use Infragistics.  This has resulted in our PDF File sizes almost doubling due to us now using Bookmarks within the PDFs and also having to embed the fonts.  There are some pictures used but these are already very small so they are not the issue.  I was wondering does anyone have any ideas of how we could possibly reduce the size again or any possible work arounds.
 Any help would be great.
 Colly (Ireland)
 
			 Where do these EPS files come from Photoshop or Illustrator?

Illustrator

There may be nothing wrong with EPS files technically, they are considered archaic in a modern workflow. Best to save as a .ai with pdf compatible file - or to save them as  PDF x4a with Illustrator Editing Capabilities enabled. 

But I don't think there's any need to run out and convert all your files - perhaps keep it in mind going forward.

Photoshop

EPS is really not the best format. If it's pure raster then PSD or TIFF would be preferred format, if it's Raster + Vector Shapes, Vector Masks, Text Layers then PDF is preferred over EPS (with photoshop editing capabilities enabled).

File sizes react differently depending on the content on the choice of compression. Heavy Vector files from Illustrator can cause Huge file sizes in PDFs. 

See this article (and more importantly the comments!)

http://indesignsecrets.com/creating-smaller-pdfs-from-a-vector-dense-book.php

If you can provide a bit more info  on your workflow and what settings you are using to save it would be great.
 
		   

 
           	 
		     A great tip for reducing PDF file sizes (e.g. from scanned images)
 
			 I just found, and used this tip and was so impressed I had to share it!
 http://www.hoboes.com/Mimsy/hacks/quality-reduced-file-size/
 By the way, you can also easily combine pdfs using preview. Open the 'main' one that will be your final file. Go to View -> Sidebar. Drag the other pdfs that you want to join right into the side bar. It will just stack them on. Then save.
 C.
 Message was edited by: Chipstix
 
			 Since a while DIAdem optimizes the size of exported PDF-files in a related way as it is suggested here. In principle the PDF-file is exported in a very high resolution, so you can display it in a reader with a very high zoom value (e. g. 6000 %) to look into details of your data. If you have a huge dataset, this could lead in fact to a bigger file size, if data points could be displayed because the high PDF-resolution. But in general, DIAdem only saves information in a PDF-file which is really necessary - but with a high resolution.
 
		   

 
           	 
		     Tips on reducing PDF file size?
 
			 I can't seem to export PDFs smaller than 5 MB from Pages. The docs I'm exporting are only one or two pages in length with one small raster image and a few vectors. Exporting to PDF even at loweset "Good" quality produces a 5 MB file.
 Things I've tried:
 The "Reduce File Size" option in Pages before exporting doesn't work––it sits forever at "Calculating file savings..." and never does anything.
 Using the Compress PDF Workflow: http://www.apple.com/downloads/macosx/automator/compresspdfworkflow.html
 This takes a 5 MB file and "compresses" it to 5.5 MB. Fail.
 Using the "Compress PDF" Quartz filter when saving from Preview. Again, it actually makes the files larger, not smaller.
 These files should be, at most, 1 MB. Any tips you have on shrinking PDF size from Pages would be greatly appreciated! Thanks.
 -i-
 
			 All,

I came across these instructions:

Reduce File Size makes PDF unreadable

at http://macmanus.nl/2014/06/23/fixed-reduce-file-size-makes-pdf-unreadable/#comme nt-11149

it is the best way to make your own filters, and it worked perfectly for me the first attempt
 
		   

 
           	 
		     Simple IPhoto Questions-How to reduce picture file size?
 
			 Hello,
 I know how to reduce the size of photos using the Mail program, but is there a simple way to reduce the size of photo files and keep them for sending through the internet at later dates. I would like to keep the photos at their original size for viewing, but transfer photos to a file where they will be used to send over the net in much smaller format size.
 thanks
 
			 As Larry says, you can resize the pics on Export using the File -> Export command.

and keep them for sending through the internet at later dates.

The intention in iPhoto is that you would only reduce the size on a case-by-case basis, rather than resize the whole library. As iPhoto always maintains the Originals this require quite a lot of disk space

Regards

TD
 
		   

 
           	 
		     Quick tip - reducing PDF file size
 
			 My STANDARD menu for printing doesn't look anything like the one that is being used in the demo.
 I do have the "cover & pages" part for *some documents*, but there is nothing there when I drop down concerning Color synching. I make a lot of PDF files and Sure would like to be able to reduce the size.
 Where did the printing menu come from in the quick tip?
 
			 npjvette wrote:

The problem with printing is cannot scan, and one printer PSC 1350 prints anything it wants with no relation to what I sent to the printer. the Business jet 1100 doesn't want to print anything. these are HP issues that are crippling my business.

I don't think there is a Leopard driver for the 1350, but you should check HP's site to make sure. There is an HP driver for the 1100. Are you using that driver? You can try deleting and re-adding the 1100 using the Leopard supplied HP driver.

there is no "compress PDF" box on my print menu under the PDF checkbox/ menu. at least on neither of my computers which both have leopard installed. this on the standard drop down menu. what print dialogue are U using.

I am using the standard print dialog. What menu items do you see under the PDF menu?
 
		   

 
           	 
		     Having problems reducing PDF file size.
 
			 Really frustrated...
 Mac 10.6.8
 Acrobat Pro X 10.1.4
 I do not have access to the originating files for the PDF in question. Original file is 268MB. 
 6.25" x 10.25" document size.
 I have used Save As Reduced file size. Increased file to 312MB.
 I have Save As Optimized PDF with smallest file size. and got the file down to 247MB.
 I printed out to a .ps file and ran it through Distiller with a custom Smaller File size taking it down to 72dpi (.ps file was 2.6GB) and got the file to 216MB.
 I did another Optimize of the 216MB file clicking everything [flattening, fonts, images, etc.] and the file came out to 530MB. (Really?!?!)
 [This also took 3.5 hours.]
 Ok, content stream at 97%. I don't know what that is or how to reduce it.
 I'd love to get this below 100MB and below 50MB would be great.
 Any help / hints / tricks / tips are greatly apprectiated.
 
			 I'm not sure that printing to a new PDF is the answer.  When I print to a PDF, my pdf size balloons (often by 3x the original size).   I've checked the settings in the print profile (verifying I'm printing to black and white, and lowering the DPI from 1200 to 300) but even at that, the finished product is often 2.5x the original.  (Background on the document ... it was paper, I scanned it at 400 dpi.  The file size was around 3 MB.  I added a footer and then printed to pdf.  The finished product was 9 MB.)  Any other thoughts would be greatly appreciated.  Thanks
 
		   

 
           	 
		     Having trouble reducing PDF file size on export
 
			 Hi, I recently switched from Quark to InDesign and am having trouble figuring out how to reduce the size of a PDF on export. 
 The file has about 200 pages with about 300 EPS files, which are approximately 30-40K each. The file uses fewer than 10 fonts, all from two font families (Bembo Std and Univers Std). When I created a similar file in Quark, the exported PDF is ~5MG. However, when I export the file I created in InDesign, the PDF is 10xs larger (~50MG). I tried exporting using the High Quality Print and Smallest File Size settings, but the result was the same. (I think that is because there are no JPG images to compress, just vector files which are already tiny.)
 If you have any suggestions for other settings to check, I would be grateful for the help. Overall, other than this issue, I have been extremely happy with InDesign.
 I am using CS5, v 7.0.4 on Mac OS X (10.6.8, Snow Leopard)
 Thank you,
 SH
 
			 Quark to the best of my knowledge still goes the Postscript to PDF route - I'm not 100% sure on that.

But here's why Export is differetn than how you print to Postscript and distill http://indesignsecrets.com/creating-pdf-export-or-use-distiller.php

Distilling is very much frowned upon, and Export from InDesign is considered the best workflow.And the file size is larger, but it does add a lot of important information to the PDF, which makes it superior than distilling.

But, there's a lot of document overhead in PDFs.

The High Quality setting is only meant as a guide.  It's not meant to be used, in my opinion, out of the box.

This explains why and how to counter it.

http://indesignsecrets.com/document-overhead-in-indesigns-pdf-can-be-huuuuuuge.php

The Help files do give some clues

http://help.adobe.com/en_US/InDesign/6.0/WSa285fff53dea4f8617383751001ea8cb3f-70b3a.html

This PDF guide is MUST http://www.adobe.com/designcenter/cs3/articles/cs3_printguide.html

And besides that EPS files are considered legacy files by Adobe, I'm not sure how they're handled on PDF export. But you'd be better off saving to .ai from illustrator from now on.

http://www.prepressure.com/library/file-formats/eps

Instead of EPS from photoshop - save as TIFF or PSD if all Raster. If it's raster + vector text layers, shapes or masks then save to PDF.

http://indesignsecrets.com/preserving-vectors-in-photoshop-files.php
 
		   

 
         
 
        
 
		 
          Maybe you are looking for
 
          	 
		     How can I get a list of everything that I've bought through Itunes in the last year?
 
			 I keep scanning over my checking account and keep finding things that are being bought by no one. Does it cost for updates? Cause I seem to be being charged for everything these days. My kid didn't have his I pod for 4 days and things were bought. Fi
 
		   
	 
		     Language Conversion for Adobe form using Web Dynpro
 
			 Hi, I want to convert the whole adobe form which have created in English to some other language using web dynpro. Is it possible. Please help me on this. Thanks & Regards, Gaurav Mittal
 
		   
	 
		     Create xml from a collection type
 
			 can anyone please explain me how to create an xml from a neseted table
 
		   
	 
		     Re-downloading illustator
 
			 i cannot re-dowload illustrator without my computer saying the version i am downloading is a fraud. i think it has something to do with adobe application manager. how can i re-download illustrator?
 
		   
	 
		     Premiere Pro 4.0 multicam issue
 
			 I am reaching my frustration level with multicam project.  I have followed ALL instructions to create the multicam sequence.   It creates the sequence, I can edit the sequence but when I save the project and go to re-open it, the project will NOT ope
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